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Part 1: ‘Prerequis&es

Tools that make coglil




#1 Check out Gromacs from Git

o get a copy of the repository from the git server:
git clone git://git.gromacs.org/gromacs.git

cd gromacs
git branch

*master

o check out the latest stable brawnch:
git checkout --track -b release-4-5-patches origin/release-4-5-patches

git branch
masker
*retease-—4~6~[aa&thes

o dont use gromacs-4.5.x.tar.gz ffc»r modifi,taﬁoms!
do create your ownh branch!



#2 Sekb up an IDE Frojea&

/usr/local/bin/eclipse Gahvma&e (Roo%)

or download Indigo/2011 at www.eclipse.org =
& . TVt File system
‘EC‘;LLPSQ IDE ‘{OT’ (-/(-""*' DQVELC}PQ‘"E” Impont resources from the local file system

i home/ckutzne/git/gromacs v Browse

File > New > C Project “my45proj”

gitignore

'FT’OJQC& Evpe: Makefile project > Empty >
Linux GCC > Finish

2
v a¢ aclocal.md

v AUTHORS
vl |-, CMakeCacha.1xt
v| |5 CMakeLists 1xt
v
”
o

File > Import > General > File SYStem - “c::ﬁp;;o;usw
select your gromacs git dir, check the R T>)

Ch&ﬂkbox W‘:&h &he Sromaﬁs source. Filter Types... Select All Deselact All
> Finish Into folder: Egroma:sr Browse..

Options

L Overarie existing resources without warning

Right-Click on the Mawbj creabked prqje& > ) i oo e
Team > Share project > Git Advanced >>



http://www.eclipse.org
http://www.eclipse.org

#3 Configure with CMake/Autotools

o cd ~/workspace/my45proj
export LDFLAGS=-L/usr/local/fftw/312-gcc412/1ib
export CPPFLAGS=-I/usr/local/fftw/312-gcc412/include
export CFLAGS="-g -00 -Wall -Wno-unused”

/ A. Makefile generation N

from Makefile.am fyom CMakelisks.bxt
AutoTools Cmake, cross-platform malke
the GNU build s:jsEem (4.5+)

Qupﬁo-éﬂix)

mkdir build

. /bootstrap cd build

./configure \ cmake
PR R e e -DBUILD SHARED LIBS=off \
__prefix=/home/me/gmx -DCMAKE_INSTALL PREFIX=/home/me/gmx \
(--enable-double) (-DGMX DOUBLE=o0ON)

\ 2. Campii,e & tnskall /

o Mmake -7 4 i celi
make install p WS¢ &Clipse



#3b Use Cemake for special needs

ccmake .. will give you an interactive settings window,

type (c)onfigure, (g)enerate

File Edit View Terminal Help

BUILD_SHARED_LIBS

BUILD_TESTING

BZRCOMMAND BZRCOMMAND -NOTFOUND

CMAKE_AR fusr/bin/ar

CMAKE_ASM-ATT_COMPILER fusr/bin/as

CMAKE_BUILD_TYPE

CMAKE_COLOR_MAKEFILE

CMAKE_CXX_COMPILER fusr/bin/c++

CMAKE_CXX_FLAGS -fexcess-precision=fast -Wall -Wno-unused
CMAKE_CXX_FLAGS _DEBUG -fno-inline -g

CMAKE_CXX_FLAGS_MINSIZEREL -0s -DNDEBUG

CMAKE_CXX_FLAGS RELEASE -fomit-frame-pointer -finline-functions -funroll-all-
CMAKE_CXX_FLAGS_RELWITHDEBINFO -02 -g

CMAKE_C_COMPILER fusr/bin/gcc

CMAKE_C_FLAGS -g -00 -Wall -Wno-unused
CMAKE_C_FLAGS_DEBUG -g

CMAKE_C_FLAGS_MINSIZEREL -0s -DNDEBUG

CMAKE_C_FLAGS_RELEASE -03 -DNDEBUG

CMAKE_C_FLAGS_RELWITHDEBINFO -02 -g

CMAKE_EXE_LINKER_FLAGS -L/usr/local/fftw/312-gccd4l2/11ib

SHARED LIBS: Enable shared libraries (can be problematic with MPI, Windows)
: & to edit option CMake Version 2.8.1
o configure

4 Press [q] to quit without generating
to toggle advanced mode (Currently On)




#4 Cowmpile from Eclipse

Project > Properties >
C/C++ Build

Project References

SEE di-r C}‘f MQRQ‘{&L@_ Run/Debug Settings

P Task Repository

WikiText
Eati,pse simptv execubes
"\MQW’Q _‘J‘«f_li

i the chosen dLreCEarv
when we Wik ctrl1-B

N\

<
File Edt Source Refactor Navigate Search %tOJS.S: - Run  Window Help

N alb Lc_)v e W hd c v 6&{ %v H "":}v Ov ‘,?' ~ 0“

b

S g

C/C++ Build

= Builder Settings | (=) Behaviour

Builder
Builder type:

V| Use default build command
Build command

Makefile generation

| Generate Makefiles automatically

Build location T =

Build directorg

Cancel




#8& Creake a branch

create a branch, start from current: o .git contains all history about every

file/version ever checked in
git branch - shows current branch

m::&er de o git checkout <branch> F-'u,&s the Latest
* - -~

reledses ot O state of files of <branch»

g:!.t branch my45feature = creabe branch inko 3‘0”’? workims bree:

git branch

master ./gromacs/src/kernel/mdrun.c
ij4{#%m&ume ./gromacs/src/kernel/grompp.c
*mﬂeasew4~64pa&ﬂwm ./gromacs/src/kernel/*.c

./gromacs/src/tools/*.c

git checkout my45feature = checlke out branch _ ;
./gromacs/include/*.h /AN

git branch
./gromacs/share/*

oo ./gromacs/ N
*mv‘f-ﬁ{e&&ure L X

reteaseﬂdr-ﬁﬂpa&ﬁkes

At any time merge hnewest bugfixes into
mfe—é’?&a&ure

git pull

git merge release-4-5-patches




#& Gk how-to

o after some programming, you

have a first version working.
git status

# On branch my45feature

Changed but not updated:
modified: src/mdlib/pull.c
modified: src/kernel/md.c

Untracked files:
src/mdlib/anewfile.c

#
#
#
#
#
#

o '@XX!! Did I change md.c?

git checkout -- src/kernel/md.c
- undoes changes

o What was it I changed in pull.c?:
git diff ./src/mdlib/pull.c

_ jatia ; . o OK, now it looks qood.
o Not 0K, this is a Fni.e of '@XX. S T A O

Let’s start over again! git add src/kernel/md.c

git add src/mdlib/anewfile.c \
git reset --hard git commit -m “Added feature XY"/



#6b Use gitk before you commit

3

File Edlt View

Local uncommitted changes, not checked In to Index
‘yﬁ e S ee0 numbé Michael Shirts <michael.shits@virginia.edu> 2011-07-2206:41:14
@ Removed JaMns from pdb2gmx. Justin A. Lemkul <jalemkul@vt.edu> 2011-07-20 18:50:05
Merge branch ‘release-4-5-patches’ of git@gil.gromacs.org:gromacs Into  David van der Spoel <spoel@anfinsen.bmc.uu.se> 2011-07-20 11:24.05
Streamlined small part of pdb2gmx Mark Abraham <Mark.J . Abraham@gmall.com> 2011-07-18 00:06:13
Added Initialization of arrays atter srenew call David van der Spoel <spoel@anfinsen.bmc.uu.se> 2011-07-2011:21:30
Reading a .g96 trajectory now causes fatal error Mark Abraham <Mark.J.Abraham@gmail.com> 2011-07-1514:14:43
fixed div by 0 in compute_lo, lixes #778 Berk Hess <hess@hess.theophys kih.se> 2011-07-1317:48:06
Added two missing headers Carsten Kutzner <ckutzne@gwdg.de> 2011-07-11 13:02:39
Fix some identifier naming issues in last commit Mark Abraham <Mark.J. Ab'aham@gmatl com> 2011-07-11 09:31:31

SHA1 ID: ) (- ~> Row/ 1/ 10548 |

XY

Find next prev commit \containing: ' Exact  Allfields
Search

¢ Dir Old version New version Lines of context 3 ‘i' ignore space change
I; clude/gmx_ana.h

#define NSTR (int)asize(citedb) | include/types/filenm.h

Includetypes/simple.h
tessssssscnsnssscncssssncnsas Bre/gmxlib/fileNm.C e ccccciiiiiniii it

index Sbaleds..704a2ds 100644 RS aTEioopyTie s
38,8 4w stati nst t deffils B\ sre/gmxdibfilenm.c

eftAsCc., ".hat*, "gk", NULL. *"Fsurier ~anstorm o Bpre ad function* 1. . IC‘OO'S'CNaKeLlStStXt

X PixMap compatible mathidx file

AN

sessssssssssscecescaccasene BIC/LOOLS/CMAKELIBLS . EXL ~vvsvervsnerssmaaaaenaas
mdax 8471ed7..ads2ffa 100644

+29,11 @@ add_library{gmxana




#7 Use an IDE (Eclipse, KDevelop, SourceNav)

=IO} X

Source Refactor Nawigate Search Project Run

g & ‘v @~ - Resource

5. Nawigator “ B  |g copyrita.c £ g_tune_pme.c gfl gmx_tune_pme.c 2 = Outhne 2

N

r
|

b
b
b
b
b
b
b

_M"_’ »"

. IABK. >33
New

Go Into

'-'l"—"" n New Window

Lopy

Delete

Moye

Ren ame

Import

Export

Refresh

Cloge Project

Close Unrelated Projects
Build Configurations
Make Targets

Index

Show in Remote Systams wew
Convent To

Run As

Debug As

Profile As

Team

Replace With
Restore from Local History

Add/Remove Rpmlint Warnings

Propenies

real_cnecbpn15t_swmulat1rn_[art(nyt?fn;”-c;1”,NFILE
&sim_part &Cpt_steps.cr,
FALSE, NFILE, fnm, NULL, NULL)

sfree(crx);

cim e bl

>

found!"

+ 41 - R R o

p",NFILE. frm), "w").

ranaatc intnrc Rintar RArsint ar

rget Task List g

all] Error 2

X_tune_pme.c

ImydSproj/srcitools

truth value

imydSproy/srchools

N W e %

S _Dencr_nrelcrdl

’ 1s_bench_option(char®, gmx_bool) . g

15_equal(raal, real)

gmx_boo!

1s_launch_file(char®. gmx_bool) : gm

opt2fn("-cpi

" 1s_main_switch({char®)

* 15 _launch option{char®, gmx_bool)

gmx_bool

® largest_common_factor(int, int) - int

* launch_simulation(gmx_bool, FILE®

* make_benchmark_tprs(const char®, «

" make grid_list(real, real, int*, matrix

* make_npme_lst(const char®, int*, int

* modify_PMEsattings(gmx_large_int_|

* parse_logfle(const char®, const char’

S

arch Type Hierarchy
Resource
my4Sproj
mydSproj
i my45proj

gmx_fune_pme ¢

gmx_tung_pme

v Location Type

C/C++ Problam
C/C++ Problem
C/C++ Problem

C/C++ Problem

{ C/IC++ Problem

Yoo, g _ s




#7b IDE benefibs

o
File Edt

Source Refaclor Nawgate Sagrch Project Run Window Help

v ¢ v c v 6v e Ov ‘gv ‘-{v \?

€

£ gmx_tune_pme.cC

¢ C Compare
¢ C Compare Viewer

gmx_tune_pme.c
read_checkpoint_simulation_part(opt2fn(
&sim_part.&cpt_steps.cr
FALSE NFILE, frm, NULL,NULL) .

~Cp1",NFILE, fnm),

sfree(cr);
Sim_part++;

1f (sim_part<=l)

gmx_Tatal (FARGS, ' 01 Tile %s not Tound!

1
1 ]

ffopen(cpt2fn( " -p",NFILE, fnm),k "w")

check_1nput(nnodes, repeats
maxPMEfraction, minPHEfraction,
fs, bench_nsteps, fnm, NFILE,
asize(pa).pa).

E&ntprs, &upfac, &downtfac,
npme_fixed,

sim_part, presteps,

9 I » )
« 'Y v 3

1f ((nnodes > 2) && (npme fixed < -1))
{

LT PV wnm e

“l

L L

Tasks & Console 22

C-Build [my45pro))

Left: 873 - 1, Right: 873 . 1, incoming change #1 (Lefti: 873 ;: 873, Right; 873 : 873)

opt2Tn(”-

=]

{ b o \ B (yResouwrce

gmx_tune_pme.c Index ()
FEaa_CnecKkpoINT_SImULatIon_parc(oprirnl
ksim_part, &Cpt_steps.cr,
FALSE,NFILE, fnm, NULL,NULL)

~CPY U NFLILE.TIM),

sfree(cr).
SIM_part++;

1T (sim_part<=l)

gmx_fatal(FARGS, "Checkpoint file %s not found!'®

. I 1
L |

fp = ffopen(opt2fn(”-p" NFILE, frm), "w");

* Hal | | { v ! ! f nnmand 1 1M )
check_1nput(nnodes. repeats., ntprs, &upfac., &downfac
maxPHMEfraction, minPMEfraction., npme_fixed
s, bench_nsteps. frm, NFILE., sim_part, presteps,
asize(pa).pa),
1T ((nnodes > 2) && (npme fixed < -1))
{
maxPMEnodes = floor(maxPHEfraction*nnodes);
minPMEncdes = max(floor(minPMEfraction*nnodes), 0)
fpraintf(stdout, "Will try runs with %d minPHEnodes) .
1T (maxPMENnodes != minPMEnodes)

(X0

Properties Make Target Task List Problems History Call Hierarchy Search Type Hierarchy




> pLeuing up X rOYMALCS

J




#¥ Molecular cifjmamws Fivme s%ep

— Read A 1, vi, i, g, potential U — read from bpr & cpt — bpxiog, checkpointe
/ 7 — Loop over MD steps — do_md( ) — wmde
‘ — Calculote forces §; — do_foree( ) — sinm_utilc
— make heighbor Lists for fip — ns( ) — NS¢
— ewvaluabe fcou and flaw up ko re — do_nonbonded( ) — nonbonded.c
— evaluate long-range fc (PME) — gnmx_pme_do( ) — pmvec
— evaluate bonded forces — cale_bonds( ) — bondfree.c
— Update positions and velocities — update_coords( )] — updatec
— (constrain positions) — update_constraints( )

— Oubput 1, v, T, p, energies, . — write_braj —> xte, cpl brr — stake



| gnaxlib

move daka

mdruin
grompp

i1 network
! ckeckFoEMf:

random #s

Eopatogj
handling

} §

file 1/0 utils §

;V | nonbonded |

mdlib

dom.dec.
edsam
u,!odo&e
PME

\ Meighbor

search
conskraints

! | genion

wmalke_edi

genbox
editconf

include

vece.

Phjsécs.h }

commrec.h
| enums.h

ﬂ) simpleh: real, |
rvec, makbrix, |
XX,YY,22 |




#10 Hacking Gromacs examples
Implementing new core functionality

preprocessing mdruin
FUNCTIONALITY SPECIAL INPUT FOR MDRUN MDRUN ADD-ONs ocUTPUT

MDY

Rotakion Indices of rotating atoms
rot. rate, k, output freq.

Robation
angle

Evaluate forces from

rotakion Fo&eh&iat

Swap | Indices of ions &
channels, swap frequency

Exchange ton positions #swaps,

channel flux

Fitting to :“ CrycEM map
CryoEM maps || freq. of force evaluation

——— e

Correlaktion
coefficient

Evaluate forces due to
eroElM map

Essential Dyna- (r Ref. & average positions,

' Cownstkrain pos. along EV / Posi&éah on £V,
mics / flooding ' EVs, k, output frequency

- Evaluate flooding forces | flooding pot.

y,
A i/

e = L —




#10 Hacking Gromacs examples
Implementing new core functionality

preprocessing MD icm[a
#11,12,13 4 ppianag anet
FUNCTIONALITY fSPECIAL INPUT FOR MDRUN 3 ———————— =

\ 7 - oUTPUT
#11,1% \/« :11111% \\

Ro&o&mv\

Rotation Indices of rotating atoms | Evaluate forces from \ |
rot. rate, k, output freq. | rotation potential i angle
Swap i | Indices of ions & ‘ Exchgxhgé Lown posi&iov\s | # swaps,
| channels, swap frequency | || . channel flux
Fitting to “\ eroE:M map }‘ i Evaluate forces due to «: Correlation
CryoEM maps | fraq of force evaxtu.ahovx ’ / ’ eroEM map ; coefficient

S = _— e -
———-—_———-—’———

_——

Essential Dyna- r ef. & avemge Posuhov\s, L.ov\sizmm pos. along EV /  position on EV, |
mics / flooding / E\/s, k, output frequency N EDI K\ Evaluate ftoodw\g forces flooding pot. /‘

\ ‘_:, — /Z// = ’is/ //

| &cs}c::-ib Lilke malke_edi: Al " \ B

/
{

l
see Camilos Techtea

- “g_tools from the
NGROMACS template”

X S ——




#11 Add a file

:- aron"p‘p‘ c & JSsre/kernel / h &3 ./Lv\ctude/&jpes/

qu bo;l = bverbose = FALSE; 11 /* this enum should correspond to the array deffile in gmxlib/filenm. ¢
warninp_t wi; 12 enum {
char warn_buf[STRLEN] ;

t filenm fom[] = {
efMOP, NULL, NULL, ffreap 3,
), "-po", "mdout", ffWRITE
"-c", NULL, ffREAD
er', NULL, ffOPTRD
“-rb*", NULL, ffOPTRD
NULL, NULL, ffOPTRD
NULL, NULL, ffREAD
“app", "processed”, ffOPTWR
".0", NULL, ffWRITE
-1, NULL, ffOPTRD

-~
D
-

)
~n (A
-

- -

Q S

:II

......

-

{
{
{
{ e
{ e
{ e
{
{
{
{

) Cpd gt gt gt gt Sged gl gl g
-

269 #define asize ‘ fXpeM
270 6 - S R
71 * Command line options * 6 FOME * ccp4 density map *
static gmx bool bRenum=TRUE; :
static gmx bool bRmVSBds=TRUE,bZero=FALSE;

Description

¢ filenm.c & /%rc/ﬁnnxid; R - grompp.mdp Input grompp input file with M
of +4 st PRy NULL, N -po mdout.mdp Output grompp input file with M
eft. .edo", "sam", NULL, "ED sampling outpu '}, 7S conf.gro Input Structure file: gro g36 |
efts .hat", gk, NULL, "Fourier transform of spgead funci|is conf.gro Input, Opt. Structure file: gro g96
efts .cub™, "pot", NULL, "Gaussian cube file" },§ -rb conf.gro Input, Opt. Structure file: gro g6 |
eft, .xpm", "root'", NULL, "X Pleap compatible matWax file[ s index.ndx Input, Opt. Index file

B cae s e : e -p topol.top Input Topology file
= i P P P M1L"T("'d““ltymaw'} -pp processed.top Output, Opt. Topology file
' — -0 topol. tpr Output Run input file: tpr tpb
-t traj.trr Input, Opt. Full precision trajector
-e ener.edr Input, Opt. Energy file

-m1 mapin.mrc Input, Opt. CCP4 density map



#11b File / option handling

Use routines in /include/filenmh
f (ir->bRot)

wi);

/* Return the filename belonging to cmd-line option opt, or NULL when

* no such option.
char * filename =

R

on the cmd-line *,




#12 Add MDP mm& pamme&ers

4

struct
nstswap;
nat;

pede
int
int
int
V int
atom 1id
atom id
atom id

nat sol;
*ind;

*ind sol;
i int

W int
| real

csteps;
threshold;

int
_} t_swapcoords;

~

nat _split[2];

*ind_split[2];

nanions [eCompNr];

ncations[eCompNr]; /*

many steps a swap 1s attempted?
atoms in the ion group

Number of atoms in the split group

Number of atoms in the solvent group

The global ion group atoms numbers

Split groups for compartment partitioning
The global solvent group atom numbers

Every how
Number of

* Requested number of anions and

Coupling constant (nr of time steps)

Ion counts may deviate from the requested
values by +-threshold before a swap is done
cations for both compartments

typedef struct {
int el;

Stark b:‘}
adding your new
variables to the
Emiv\puﬁrec
skructure

e —— e\

int simulation part;
int
int
int
int
int

nstlist; *
nstlog; *
nstxout; o
nstvout; ‘
nstfout;
int nstenergy;
int nstxtcout;
double init t;
double delta_t;

int eSwapCoode:
t_swapcoords *swap;

} t inputrec;

gmx_large_int_t nsteps;

gmx_large int t init

* Integration method
* number of steps to be taken
* Used in checkpointing to separate chunks *
step; * start at a stepcount >0 (used w. tpbconv)
number of steps before pairlist is generated *
number of steps after which print to logfile *
number of steps after which X is output *
id. for v *
id. for F y
number of steps after which energies printed
id. for compressed trj (.xtc)
initial time (ps)
time step (ps)

E.nc:tude/&-jpes/ ihpu&rea.h




#12b Ad4 MDP input parameters

o grompp parses MDP file

* PARAMETER £J 0 : R‘QfV\EL/SVOMPP.C const char *eSwapDim names[eswapdimVR+l] = hames.c
mdparln = Opthn(" f" “FILE fnm)' ""0", uxu’ llYll' IIZII’ "dlllo", NULL

set_warning_Lline(wi,mdparin,-1); }:
get 1r(mdpar1n opt2fn(*-po*, NFILE fom), ir opts,wi);

enum eSwaptype {

eswapNQ, eswapX, eswapY, eswapZ, eswapAuto, eswapdimNR
}.
A ! ¢ include ftypes/enums.
o teach gek_ir to parse the new entries: bl d

804 void get_ir(const char *mdparin,const char *mdparout, 1150 /R RS e B— S
805 t_inputrec *ir,t_gromppopts *opts, it el Wi M ot B e SO B2 i S

204 e PR % 1152 EETYPE("swapcoords", ir->eSwapCoords, eSwapDim_names);
ff“/'{ P_ .‘é 1153 if (ir->eSwapCoords != eswapNO)
= 1154 (. —
808 char *dumstr([2]; g 1155 snewlir->swap,1);
809 double dumdub [2] [6] ; \3: 1156 CIYPE("Swap attempt frequency");
810 t_inpfile *inp; < 1157 ITYPE("swap frequency™, ir->swap->nstswap, 1);
811 const char *tmp; < 1158 CTYPE("Two index groups that contain the compartment-partitioning
812 1int i,7,m,ninp; {J 1159 STYPE("split_group0", splitgrp0O, NULL);
515 char  warn_buf [STRLEN]; 3 1160 STYPE("split_groupl", splitgrpl, NULL); :
814 1161 CTYPE("Use center of mass of split groups (yes/no), otherwise geo
P . i d innfile(md o . s 1162 EETYPE("massw_split0", ir->swap->massw_split[0], yesno_names);
: > 1np = read_1nptilelmdparin, &ninp, NULL, wi); 1163 EETYPE("massw_splitl", ir->swap->massw_split[1l], yesno_names);
ol6 1](.‘
517 snew(dumstr[0],STRLEN); 1165 CTYPE("Group name of ions that can be exchanged with solvent mole
815 snewl(dumstr([1],STRLEN); 1166 STYPE("swap_group", swapgrp, NULL);
819 1167 CTYPE("Group name of solvent molecules");
820 "RUN CONTROL PARAMETERS"); 1168 STYPE("solvent_group”, solgrp, NULL);
521 | EETYPE(Pintegrator", 1ir->el, ei_names); 109 , : : : .
822 RcTYPE (BStart time and timestep in ps"); 1170 (.lYPl:("Spllt.'c'ylmd(.-r. radius, upper .md.lowcr extension [nm] (th
a rRTYPE (Btinit" RS R RTY 1171 RTYPE(*"cylo 1 , §r->swap->(y10r, 2.0);
’ : ittt 1172 RTYPE("cylo up" , ir->swap->cylou, 1.0);
524 | RTYPE (Pdt™ del ¥ B .
"I R .PE t"' "1r'>.e ta_t, 0.001); 1173 RIYPE("cylo_down", ir->swap->cylol, 1.0);
625 | STEPTYPE (“nsteps™,  ir->nsteps, 0); 1174 RTYPE("cyll_r , ir->swap->cyllr, 2.0);
826 § CTYPE (PFor exact run continuation or redoing part of a run") 1175 RTYPE("cyll up™ , ir->swap->cyllu, 1.0);
827 § STEPTYPE ("init_step",ir->init_step, 0); 1176 RTYPE("cyll _down", ir->swap->cylll, 1.0);
828 § CTYPE ("Part index is updated automatically on checkpointing L1177
629 FITYPE (Psimulation_part", ir->simulation_part, 1); st CIYPE(:Solvt"t "ﬁm‘.’"k rond ["m']_"); =
830 § CTYPE ("mode for center of mass motion removal"); “/,' RIYPE("r—SO vent", ir->swap->r_sol, 0.5);
531 | EETYPE( "comm-mode" ol Dade ecm. Rames) 1180 CIYPE("Average the mll!lber of ions per compartment over these many
s3> ¥ crype “' R ‘t g e ’f - ' A 1) 1181 ITYPE("coupl_steps™, ir->swap->csteps, 10);
83. gnumber ot steps Tor center o7 mass motion remova ’ 1182 CTYPE("Requested number of anions and cations for each of the twe
633 \ITYPE {*nstcomm", 1r->nstcomm, 10); 1183 CTYPE("-1 means fix the numbers as found in time step 0");

("group(s) for center of mass motion removal"); 1184 LTYPE("anions0" . ir->swap->nanionslo]l . -1):



#13 Write new Far&me&@.rs to %pr

grompp
> write tpx state( )
> do tpx( )

> do inputrec( ) W gmxlib/tpxio.c writes ir ko

TPR

erease bpx_version!

¢ tpxio.c &3 c| grompp.c

66/* This number should be increasgd whenever the file format changes! *

b/static const int tpx_version

hDum=gmx_ft1o0_ndo_rea F :
boum=gmx_fio ndo_real( "o ir- >et[J] a, 1r set[j]. n)
bDum=gmx_fio ndo_realffio,ir->et[j].phi,ir->et[j]l.n);

}

* Swap i1ons *

if(file versnon>€22>
{

gmx_fio_do_int(fio,ir- >eSwapCoords)
if (ir->eSwapCoords != esuap.o)

{ ==
if (bRead) _
snew(ir-=swap, 1);

2¢O (fio,ir->swap,bRead, file_version);

* QMMM stuff »

if(file version>=39){
gmx_fio_do_gmx_bool(fio,ir->bommm);
gmx_fio_do_int(fio,ir->QMMMscheme);
gmx_fio_do_real(fio,ir->scalefactor);
gmx_fio do_int(fio,ir->opts.ngQM);

apcoords(t_fileio *fio,t swapcoords *swap,gmx_bool

gmx_fio do_int(fio,swap->nat); puts an integer
gmx_fio_do_real(fio,swap->threshold); puts a real
gmx_fio_ndo_int(fio,swap->ind,swap->nat); puts N integers

gmx_fio [nldo [real, float, double,

gmx bool, 1int,

gmx large int,

uchar, ushort, rvec,

ivec, string] (fio, 1teml, n]);



]

void prlinputrec(FILE *fp,int indent,

{

14 Malke gmxdum[a WOT

checle whebher new daka wmade ik bo TPR

gmxdump
> list tpx( )

> pr inputrec( ) Un.gmxlib/txtdump.c¢iumnpsjr

gmx_bool bMDPformat)

PI("userintl",ir->userintl);
PI("userint2",ir->userint2);
PI("userint3",ir->userint3);
PI("userint4",ir->userint4);
PR("userreall",ir->userreall);
PR("userreal 2", ir->userreal 2);
PR("userreal3",ir->userreal3);
PR("userreal4",ir->userreal4);

———

Z : = e e
PS("eSwapCoords", ESWAPDIM(ir->eSwapCoords));
if (ir->eSwapCoords !'= eswaphNO)
pr_swap(fp,indent,ir->swap);

PS("boMmMm, BOOL(1r->bQMMN) ) ;
PI("QMconstraints®,ir=->QMconstraints);
PI("QMMMscheme®, 1r->QMMMscheme ) ;
PR("scalefactor",ir->scalefactor);

also mdrun F?T‘E,V\F:s this ko md.log!
mdrun

> runner( )

> pr_ inputrec( )

const char *title,t_inputrec *ir,

e T e -

PorB_WT_1M_dQl12. tpr:
inputrec:
integrator
nsteps
init_step

md
2500000080
e

userintl
userint2
userints
userint4
userreall
userreal2
userreals
userreal4s
eSwapCoords
frequency
cyl®e_radius
cyl®_upper
cyle_lower
cyll_radius
cyll_upper
cyll_lower
coupling_steps
threshold
nanionse®
ncationse® 814
splitgroup®_massw FALSE
split atoms group © (16548):
split atoms group ©[9,...,16547]

L)
@

USSP UOIONODDODOD DD OO O
@
@

852

mw nmnmmwmmmnunmmmmnmmnmmmemmnmmmmwmnmmnm

nanionsl = 846
ncationsl = 820
splitgroupl_massw = FALSE

split atoms group 1 (16548):
split atoms group 1[0,...,16547]
swap atoms (3332):

{16548, ...,330

{6.,....16547)

swap atoms|[©,...,1665] = {128968,...,130633}
swap atoms[l1666,...,3331] = {(2265067,...,228172)

solvent atoms (157044):

solvent atoms[®,...,78521] = {45978,....128499)

enlvant atonmel 788959 1574%) =

IMTA7817 = 99%&



Mmoaule compil

!At—:b:‘;“

- add_l1ibrary(gmxana

autocorr.c expfit.c polynomials.c levenmar.c
ELEL R pp2shift.c dlist.c

eigio.c cmat.c

gmx_trjconv.c gmx_trjcat.c gmx_trjorder.c gmx_xpm2ps.c
gmx_editconf.c gmx_genbox.c gmx_genion.c gmx_gencont.c

gmx_ (onpr c gmx_eneconv.c gmx_vanhove.c gmx_wheel.c
4 s, calcpot.c edittop.c gmx_bar.c
gmx_pme_error.c gmx_options.c

f target_link_libraries(gmxana md gmx ${GSL_LIBRARIES})
~ set_target_properties(gmxana PROPERTIES OUTPUT_NAME "gmxana${GMX_LIBS_SUFFIX)" S

ful List of programs with single corresponding .c source file,
# used to create build rules automatically.

11bmd@LIBSUFFIX@_la_SOURCES = \ #

calcmu.c calcvir.c constr.c \ set (GMX_TOOLS_PROGRAMS
coupling.c \ do_dssp editconf eneconv genbox genconf genrestr g_nmtraj
domdec.c domdec_box.c domdec_con.c \ make_ndx mk_angndx trjcat trjconv trjorder g_wheel

4 domdec_network.c domdec_setup.c domdec_top.c \ xpm2ps genion g_anadock make_edi g_analyze g_anaeig

\ g_angle g_bond g_bundle g_chi g_cluster g_confrms g_covar
ewald.c \ g_current g_density g_densmap g_dih g_dielectric
= forcerec.c \ wine

ghat.c init.c \ (_spot (_spatial g_tcaf g_traj g_tune_pme g_vanhove

mdatom.c mdebin.c minimize.c \ : _Clustsize g_mdmat g_wham g_sigeps g_bar

mvxvt.c ns.c nsgrid.c \ §_membed Jy pme_error g_rmsdist g_rotmat g_options

4 : s, gmx_qghop_xml.h \

\suapcoords c ) \ e b sl Fa i

ereep gt groupcoord.h \ R e Rl .

pme.c pme_pp.c pppm. ¢ \ .ﬁ-._'.-.-‘."'“" R Xt *_'f;j@

LDADD = ../mdl1b/11bmd@LIBSUFFIX@.1a ../gmx11b/11bgmx@LIBSUFFIX@.1a - : ¥ **EEEE 2

' m 2 "-ll'.



#16 Decide where to inkterface mdrun

ieep your mdrun foo&yrm& small

| P
o “}

| - init parallel // broadcast to other procs e Datks mvmoduie
| | . nik_swapcoords( Yol

= init domain decomposition( )
prie_init  nik_rot( )

T nik_edsam( )

| alloc mem, |
open oukpul |
files |

_ do mvmodule
2 do,_smpcoords( h)
" do_rotakion( )
s do,__ed,sam( )

every n-th ;‘

~, | LOOP Oy
lf Ea | time step

artltlon _system( )

¥

S
e

k 1.\.

= S % yd ' # ¥ (fmwh mvmociu,i.e) Ao
SR Y _‘ s ' fumish_rot( ) close fd.es

_II o, updatexcorrstralnts =)":L,, |
- constrain( ) LINCS sn I:‘Z (

= write traj( )

| -~ replica exchange( ), o

\ |

P ‘ flnlSh run( )

— e ——— =~ —  —— -




#17 Leb wmdrun read jc;mr TPR enkries

already done! e e

T " P
. i "
i .‘

o

- " -
#13 Write new mdp entbries to &Fr

; ?wribe.r_!: ) o Wdrunner( )

> do_tpx( ) > read tpx state( )

| >dah~p&nc()bxgnmﬂbﬂ:rxhc»r&ulrbo&rr > do_tpx( )

> do_inputrec( )

3owtpx_v¢rsioh!

A gmxlib/tpxio.c
g tpro.c 8 o grompp.c 1‘@.0@&3 h" ‘{T‘OM T‘Pﬁ

66 115 number should be increasgd whenever the file format changes!
6/* 1 L hould b }gli the file f t cl { »

b7static const int tpx_version = (/3]

o
M’U-'Pl fio ndo real( ,:i,.,,u;l:: ir- xll:l‘n) static void do_swapcoords(t fileio *fio,t swapcoords *swap,gmx_bool
bDum=gmx_fio_ndo real)fﬁo.ir-»tljl.phl ir-setljl.n); Rt //"
‘ /m!/f ik
- 92 * Swap ions * - W (i gmx_fio do_int(fio,swap->nat); puts an integer
| 2 iilfile_vusiot»@ o gmx_fio do reallfio,swap->threshold); puts a real
{ ' gmx_fio _ndo_intl{fio,swap->ind, swap->nat); puts N integers
{ E gmx_fio_do_int{fio,ir->eSwapCoords);
' ] if (ir->eSwapCoords != eswapvo) : gmx fio [nlde [real, float, double,
‘ 2 { i gmx_bool, int,

it (bRead) — gnx large int,
| ‘ snevhr,»ﬂap. T uchar, ushort, rvec,
(fio,ir->swap,bRead, file_version); ivec, string] (fio, item[,

* oMM stuff =,

ififile version>=39){
gmx_fio_do_gmx_bool(fio,ir-sbgumm);
gmx_fio do_int{fio,ir->QMMMscheme);
gmx_fio_do_real(fio,ir->scalefactor);
gmx_fio_do_int{fio,ir->opts.ngam);




t inputrec

nsteps

. delta ty/ Pps
- rcoulomb / nm f§
- rvdw / nm

- userint*
userreal*

t yourmodule

#1¥ In the MD i.c;:-o[p

Variables you might heed

E

step
X[0...nat-1]
v[0...nat-1]
f[0...nat-1]

md->chargeA[0...nat-1] charges / e

:
4

gmx mtop atomnr to atom(gmx mtop t, int nr, t atom atom)

gmx mtop t

atom => m, q, E-jpe

tivme / &
time sEe_F? #H

posi,&i,oms /S am

velocities / m Ps“l i

forces / kI mol™! nm?

gmx mtop atominfo global -» atomihame, resname

t state

natoms

' box[3][3] / nm
L ORETIE onm
:va[ ] / nm ps-!

{ chargeA / e

t mdatoms

nr
massA / u

typeA




#19 O‘MEPM&

Why not write an XV& file?

fstatic FILE *open_rot_out(const char *fn, t rot *rot, const output_env_t oenv) i;A~a-~:~mr e s LA i&\i&m“ yyqjychyci&¢igﬂl )

FILE *fp;

int q;

t_rotgrp *rotg;

const char **setname;

gmx_enfrotgrp_t erg; * Pointer to enforced rotation group data *

if (rot-senfrot->Flags & MD_APPENDFILES)
{ —
- fp = gmx_fio_fopen(fn,"a");

}
else
{ Vo = — . - - - et -

fp = xvgropen(fn, [degrees] and energies [ki/mol]", oenv);

; FTOT=DASTrouNT > 1-7 81"
for (g=0; g<rot->ngrp; g++)
{

rotg = &rot->qrplgl;

erg=rotg->enfrotgrp;

fprintf(fp, "# ROTATION GROUP *d, potential type '%s':\n" erotg_names[rotg->eTypel);

fprintf(fp, "# rot_masswid %s\n" yesno_names [rotg->bMassw]);

fprintf(fp, "# rot_vecw:d %12.5e %12.5e %12.5e\n" rotg->vec[Xxx], rotg->veclYY], rotg->vec[zZ]);

fprintf(fp, "# rot_rate%d %12.5¢ degrees/ps\n" rotg->rate);

fprintf(fp, "# rot_k°%d %12.5e kJ/(mol*nm*2)\n" rotg->k);

Al
setname [0] "tﬁcta_re 0 / deqrees";
setname[l] = "theta_fito / degrees";
setname|[2] “taud / kJ3/mol";
setname [ 3] “enerqy® / kJ/mol™;
. xvgr_Llegend(fp, 4, setname, oenv);

RN

}

return fp;




#19b QOuk Pu,%

ij not write an XVG& file?

theta_refD) / degrees
25000) theta_fit0 / degrees

taut) / KJ/mol

energy() / kJ/mol

ies / k)/mol

o

# This f1le was created Thu Jan 13 11:37:46 2811
# by the following command:

# mdrun_mpi -s ../grompp-new/r.tpr -v

*

# mdrun_mpi1 1s part of GR O M A CS:

w

# Great Red Oystrich Makes All Chemists Sane

—
N

~
<

10000

title "Rotation angles and energy"”

xaxis label "Time / ps"”

yaxis 1label "angles / degrees and energies / kJ/mol"

@TYPE xy

# Output of enforced rotation data 1s written in intervals of 1 time step.
=87

angles / degrees and ener

PeOeN

= # ROTATION GROUP ©, potential type '"iso':
— # rot_masswé yes
0.4 0.6 # rot_vecé 9.90009e-01 -5.79781e-063 -1.40887e-01
Time / ps # rot_ratee® 1.00000e+01 degrees/ps
# rot_ke 5.00000e+02 kJ/ (mol*nm”2)
o oy
S350, 99, e @ view ©.15, ©.15, 6.75, ©.85
@ legend on
@ legend box on
@ legend loctype view
@ legend ©.78, 0.8
@ legend length 2
@ sO legend "theta_ref® / degrees”
@ sl legend "theta_t1t® / degrees”
@ s2 legend "tau® / kKJ/mol"
@ s3 legend "energy® / kJ/mol"
v
# time theta_ref® theta_ftite taue energye
0.000e+00 0.00080 0.00080 4.207e+00 9.415e-83

2.000e-03 ©.02086 0.60608 B.164e+861 1.656e-81



#20 Wank more?

Eo»[pits not covered

— actually write your module!  homework )
— writing to checkpoint file

— parallelisnm / dowmain decomposition

— best practices C coding

— g.something is hot working correctly, What can I do?

— 7

———
“\
~
ol I
. —
)
“— '
% et /
-
»
gl 5 P



